Dedicated to the memory of Richard Rohde

President’s Corner
by N.C. Sizemore

I’m writing this from Seattle
over labor day week-end.
For the past three plus weeks
Shelley and I have been in
Alaska, Canada, and Seattle.
Even though our thoughts were mostly on photos,
wildlife, landscape, and travel more-so than OMUG,
I think I have thought about you at least once every
day. I was sorry to hear that Phil was
sick on meeting day and happy that we
have such great backup that Tim could
bring an interesting program.
The dialog about our meeting place
continues and I will get into it as soon as
I return on the 8th.
On the trip, we brought Shelley’s
5-year old iBook (it is smaller than my
PowerBook) and it has performed well.
I saw several other MACs being used at
hotspots on ships, airports etc. I saw one
article on the Internet chastising Apple
for being slow (29 days) to fix some java
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security flaws in Leopard. The same article said
these flaws have not been fixed in Tiger and that they
could enable a hacker to take over your computer
and make it a zombie. I have not confirmed this, but
it appeared to be a responsible report.
Highlights of the trip are: Boat tour out of Seward
AK to Fjord Nat’l Park including sightings of eagles,
sea otters, harbor seals and whales in the distance
plus time at the base of a glacier to see it calving
(ice breaking off and falling into the sea.); Visit to
Alaska animal conservation refuge to
see moose, bears, caribou, and an eagle;
Wasila Walmart (en-route to Denali) TIP:
good selection of souvenirs at the best
prices around: view of south face of Mt.
McKinley at dust; a dog sledding exhibition in Denali Nat’l Park; trip to Fairbanks where we visited Pioneer
Village (I had a caribou steak sandwich
for lunch – Shelley had a reindeer meat
hot dog) and we rode a stern-wheeler
paddle boat actually propelled by the
paddle-wheel (driven by a diesel); saw
another— cont’d on page 5.............................

Photographer: N.C. Sizemore

South Face of Mt McKinley from Talkeetna, Alaska
which is 60 miles South of the mountain
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Apple’s Sleek OS X Upgrade.....

Mac OS X Snow Leopard a “sleek upgrade”:
Excerpt from David Pogue– N.Y. Times

Mac OS X Snow Leopard Review:
Excerpt from V. Nguyen–Slashgear.com

Buying software is not like buying a vase
or a comb or a lawn mower where you
pay, you take it home, and the transaction
is complete.

Ask any Mac owner and they’ll likely
tell you the Apple allure is a game of
two halves: the reassuring hardware and
the slick, consistent OS. Apple is finally
delivering their latest version of OS X,
v10.6 Snow Leopard, adding a new coat of
polish to the company’s software prowess. SlashGear has been testing out Snow
Leopard over the past few weeks, and
we’ve found that perhaps its most satisfying aspect is that it upgrades things both
visibly and less obviously, rather than
one or the other. Consider the HD space
cut, why 64-bit matters, how Apple has
streamlined the way you interact with
your data, and much more, Snow Leopard
might just be the bargain of the year.

No, buying software is more like joining a
club with annual dues. Every year, there’s
a new version, and if you don’t upgrade,
you feel like a behind-the-curve loser.
There’s a time bomb ticking in that
business model, however. To keep you
upgrading, the software company has to
pile on more features each time. Sooner or
later, you wind up with a huge, sloshing,
incoherent mess of a program; a pile of
spaghetti code that doesn’t run well and
makes nobody happy.
You’re in even worse shape if that bloatware is your operating system — the
software you run all day. Just ask anyone
with Windows Vista.
This year, though, Apple and Microsoft
both realized that the pile-on-features
model is unsustainable. Both are releasing
new versions of their operating systems
that are unapologetically billed as cleanedup, slimmed-down versions of what came
before.
Microsoft’s, called Windows 7, comes out
in October. Apple’s, called Mac OS X 10.6
Snow Leopard, arrives on Friday, a month
earlier than announced. (Apple to Microsoft: “Surprise!”)
Apple’s release strategy is highly unorthodox: “Leopard, a.k.a. Mac OS X 10.5, was
already a great OS-virus-free, nag-free and
not copy-protected. So instead of adding
features for their own sake, let’s just make
what we’ve got smaller, faster and more
refined.”
What? No new features? That’s not how
the industry works! Doesn’t Apple know
anything?
And then there’s the price of Snow Leopard:
$30. —Click to learn more

Ease of installation
There’s a lot to be said for an OS upgrade
that makes reliability its initial promise,
and we had no issues installing Snow
Leopard – a roughly 30 minute endeavor
– on any of our test machines. OS X 10.6
also leaves your existing apps and data
untouched – though we’d argue that such
behavior is an expected aspect rather than
a boasting point these days – together
with being designed to seamlessly pick
up the install baton at a later point should
your first attempt be interrupted. It’s hard
to imagine that people might attempt to
upgrade their MacBook while running on
battery only, but some will and they – together with those interrupted by power
cuts, burst fuses and similar – can rest
assured that Snow Leopard will resume
without data loss. Incidentally, while Apple
requires 5GB of free space for the install
process as a whole, Snow Leopard in fact
frees up a total of 7GB previously used by
Leopard once the update is complete.
Dock, Finder and Preview
The most obvious changes once Snow
Leopard is installed are, arguably, those

—Click to read more

Upgrading to Snow Leopard– Where Do I
Start? – book reviews by Philip Davis– OMUG
Consider this -- You’ve just received your
long-awaited copy of Snow Leopard and
are chomping at the bit to try it out on
your computer. You quickly open the box, pull
out the DVD, pop it in the machine and then think
– wait a minute, maybe I should slow down a little.
“With each major release of Mac OS X,
Apple makes improvements and changes
to the installer. Usually these are relatively
minor and self-explanatory, but the Snow
Leopard installer is different in profound
ways that may significantly change your
approach to upgrading. Even if you’re
intimately familiar with the process for installing Leopard, you should be aware of
the ways in which Snow Leopard differs.”
My normal upgrade practice has always
been to charge ahead blindly – so far I
have always been lucky. However, this
time I’ve decided to be more cautious and
follow the steps outlined in two new eBooks
from TidBITS Publishing Inc. Both of these
are available at a discounted price of $7.00
and $10.50 to OMUG members; well worth
the investment to keep me from making
some of the more obvious mistakes.
After skimming both books I went back
and read them carefully before I started
the process of upgrading my Mac Pro to
Snow Leopard.
Take Control of Upgrading to Snow Leopard, v1.0
by Joe Kissell takes you through the process of understanding the new installation
options, preparing your computer for the
update, upgrading to Snow Leopard, and
troubleshooting any upgrade problems.
This book contains a lot of details, not all
of which you need to know.
“But before upgrading, you should be
familiar with the overall process. And,
regardless of the order in which you read
this book, — cont’d on page 5................
SEPTEMBER 2009 | MUGSHOT Newsletter |

2

TIP OF THE MONTH—
Burn Several Times to the Same
Disc— Did you know that it’s
possible to burn to one CD
or DVD multiple times?
The trick is to use the “Leave
Disk Appendable” option in
Disk Utility, located in the
Utilities folder on every Mac. First step is to create
a folder and fill it with the stuff you want to burn.
From there, open up Disk Utility (Macintosh HD/
Applications/Utilities), pull down the File Menu, select
New, and then Disk Image From Folder in the submenu.
When the resulting window opens, find that
folder you just created and click the Image button.
Select a destination for your image, and click Save.
The disk image, ending with .dmg, will shortly appear on your desktop and along the left side of the
Disk Utility window. Click once on its icon in Disk
Utility, then click the Burn button at the top left of
the Disk Utility window.
Here’s the trick: When you click the Burn button, a dialog box will pop up asking you to insert
a disc—go ahead and insert the disc, then click the
blue triangle on the right side of the window and
click the box next to Leave Disk Appendable before
hitting Burn. Next time you need to burn a disk, just
repeat the process; when you get to the final step, the
button will say Append instead of Burn. n

APPLEsauce from the Mother Ship
TUTORIALS, TUTORIALS & MORE TUTORIALS
iPhoto ‘09 | iPhoto ‘08 | Aperture 2—
The Mother Ship wants to help you get better
use out of its popular photo programs. Posted on the
Apple website are 27 video tutorials on iPhoto ‘08 &
22 tutorials on the ‘09 version. There are also tutorials
on using Apple’s Aperture 2. Just click the tab of your
choice of the three and it will take you to a clickable
listing of the tutorials available. Most of the tutorials
for iPhoto ‘08 are also applicable for use in the ‘09
version. Topics covered are: • getting started • organizing your photos • making web galleries creating
slideshows• importing • enhancing • cropping •
reducing red-eye • applying photo effects • creating
cards... and more. This is FREE folks. Go to:

SCANNING TIP—

When you scan something that is printed on two sides,
the strong scanner light often sees-through the paper
stock and reproduces some of the image or text from
the reverse side (see BEFORE above). This is particularly true when scanning newsprint or even lightweight magazine paper stock.
Here’s the trick: Place a black card or black sheet of
paper behind your text or image to be scanned. Then
scan and presto, most all of the annoying “printthrough” will be gone, saving lots of clean-up time. n

NEW OMUG MEMBERS
Two new members joined OMUG
at the August Meeting. Please welcome:
• Antonio Bunker •
• Betty Lawrence •

TIME MACHINE ???????
Take a video tour through Time Machine basics.
It only takes a few minutes and it can help
clear-up your questions.
Go to the gateway page link below and look
for the Time Machine tutorial link :
http://www.apple.com/findouthow/mac#tutorial=leopardtimemachine

http://www.apple.com/findouthow/photos/
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Inside ADDRESS BOOK— part 2
Here is another tip to save you time and let you make the
most of Address Book. This is a continuation of the Inside
Address Book feature presented last month.
Using vCards —
In reality, most people using a computer don’t have
.Mac or even an Apple Computer so the standard
way to share contacts is using vCards. A vCard is a
file containing a contact’s information that you can
attach to an email and send to whoever you want.
Luckily, vCards work really well with Address Book.
To create a vCard for a specific contact, select the
contact from the list and right-click (Control-click)

are done, choose “Make This My Card” from the
Card menu. You will notice that your icon in the list
changes and your photo now has “me” written in
the corner. Now you can export your vCard using
the method above to send your contact details to
everyone in your address book.
Restrict Private Information
If you don’t want to share all of your contact information with everyone you send your vCard to, you
can choose to keep certain parts private. Go to the
Address Book Preferences and check “Enable Private
Me Card”. Now when you edit your own card, you
can use the check boxes to choose which information
is exported as your vCard.
Printing Envelopes
You can print an envelope addressed to a contact by
choosing Print from the File menu with the chosen
person selected. In the print dialog choose Envelopes
from the Style pop-up menu. As an interesting quirk,
Address Book will address the envelope to everyone
in the household if you have specified a spouse or
child in the person’s entry. For more information,
check it out by clicking this Mac OS X Hints page. n

iWeb FAQ: Tutorials, Tips and Tricks
on the name as shown above. From the pop-up
menu that appears, choose “Export vCard...”.
The file (see graphic) will then
appear on your desktop. You
can then attach the vCard to
your out-going email to share a
contact.
To create a vCard that contains
the information for all the people
in a certain group, select the group you want from
the list, right-click on it and choose “Export Group
vCard...”. If you receive a vCard from someone else
as an email attachment, you can add it to your address book in a couple of ways. If you received it in
Mac OS X’s Mail application, simply drag it from the
email message across to Address Book. If not, save it
to your Hard Drive and then choose Import vCards
(Command-O) from the File Menu in Address Book.
Make Your Own Card —
It can be quite useful to create an entry
for yourself in Address Book as it is
used for things like Autofilling forms
in Safari. To do this, create a card as
usual and fill it with all your information. Once you

Apple would like us to think that we don’t need
instructions to use iWeb. In truth, it isn’t hard to use
but there are always things that we overlook. iWeb
FAQ is an unofficial web site dedicated to helping us
use iWeb. Some of the topics covered are:
1. General Tips
2. General Troubleshoot
3. Useful Applications
4. Backup and retrieve a website
5. How can I make a backup of my iWeb website? How can I
retrieve my website?
6. Two computers: How can I edit one website from two
computers?

There is more, but you should explore on your own.
I think you will find that iWeb will do more than
you expected. See it here:
http://iwebfaq.org/site/iWeb_FAQ.html

Coming Next Month— Creating tough-tocrack passwords and keeping track of them
when you do.
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President’s Corner, cont’d from 1— dog sledding

exhibition and other exhibits; an airplane ride to 20,500’ to
see Mt. McKinley in the clear (it is 20,300’ tall and is
usually fogged in); a 66 mile bus ride (each way) into the
park with several clear views of Mt. McKinley, a mother
bear and two cubs, some moose, and caribou; on the drive
back to Anchorage we clearly saw Mt. McKinley again
from the North, East and South. All these views are like
getting holes-in-one two days in the same week! I forgot to
mention that we also saw a mother moose and two calves
on the road our B&B was on.
Our cruise started in Whittier and ended in Vancouver
with shore stops in Skagway, Juneau, and Ketchican and
a glacier/whale viewing stop in Glacier Bay. At Skagway
we rode an old mining railroad into Canada and took a bus
back stopping in Liarsville for a short play and a salmon
bake. At Juneau we were scheduled for a helicopter ride
to a glacier and a dogsled ride on the glacier. It was cancelled due to the weather, to our great disappointment.
At Ketchican we did a boat tour of the area and saw several eagles and some interesting landscapes. A short horse
drawn trolley tour followed around the downtown area.
In Vancouver we took a bus tour around to see the
sights and then did a more leisurely tour of Stanley
Park – a huge city park with lovely gardens beaches and
displays. We took a bus on a ferry to Victoria. In Victoria
we had a pedicab tour of the downtown area and spent
one full day at an old fort/lighthouse followed by a trip
to Butchart Gardens where we toured the gardens in
daylight, had dinner and went around again after dark
to enjoy the special lighting. These are the most beautiful
gardens I have ever seen.
We took the Victoria Clipper (a high speed passenger ferry – 30 knots) to Seattle. In Seattle we went to the
observation tower on the space needle and to the aircraft
museum as the highlights. Going to church tomorrow
with a friend and home on Monday. Will sleep late on
Tuesday and then start trying to catch up on a months
worth of duties.
Looking forward to seeing you in September! n

selected the automatic install (default). One hour later I had a
fully functional Snow Leopard installation!
Once I finished the upgrade, I went to the next book.
Take Control of Exploring & Customizing Snow Leopard, v1.0 by Matt
Neuburg helps you master the new features in Snow Leopard.
The author recommends taking a three-stage approach to getting
comfortable with the new operating system:
1. First, perform the customizations that will immediately
improve your user experience.
2. Learn about new features.
3. Catch up on remaining customizations whenever you have time.
Here are some of the main new features that are discussed in
detail in this 165-page book that is loaded with useful tips:
•
•
•
•
•
•
•

New Exposé options.
New system-wide text features.
Revamped Services.
Easy keyboard layout access.
Improved Time Machine management.
Smarter searching.
QuickTime player alterations

One very useful tip provided by the book is to “Block the Big Bang.”
“Big Bang is scientists’ name for the initial instants after creation
of the universe, when things were changing fast and the laws of
physics were wacky. Well, Snow Leopard has its own Big Bang! “
“When you first start up into your newly installed system, Snow
Leopard may try to do some things automatically—things that
can slow down your computer & make your life unpleasant. So the
first customizations you should make are to forestall the Big Bang.”
“If you’ve already installed Snow Leopard and started it up,
it’s probably too late: you’ve already experienced the Big Bang.
But if you’re reading the book before installing Snow Leopard,
forewarned is forearmed—the moment your computer starts
up in Snow Leopard for the first time, that’s the moment to Stop
Spotlight and Take Your Time With Time Machine. You should also
consider whether you want to Arrest Automatic Updates.”

Phil Davis Book Reviews, cont’d from 2— you should perform the

I took the book’s advice and turned off Spotlight and Time
Machine before installing and am now in the process of learning
some of the new features … this will take a while.

listed tasks in the order given— for example, back up your files
before cleaning out cruft (ed. junk).”

The final result for me has been a completely uneventful upgrade, partly due to some of the tips I learned from these books.

Here’s a brief overview of the steps you should take.

Here are links to order the books at the discounted price:

•
•
•
•
•
•
•

http://www.takecontrolbooks.com/snow-leopard-upgrading?pt=TCMUG&cp=C
PN90219MUG

Find out what’s new in the Snow Leopard installer.
Make sure your hardware can run Snow Leopard.
Back up your files!
Get rid of clutter.
Decide on an upgrade strategy (automatic, or erase & install).
Update your software.
Configure your system.

http://www.takecontrolbooks.com/snow-leopard-customizing?pt=TCMUG&cp=
CPN90219MUG

These provided me with a good road map for proceeding with
the most important step being to make a good, bootable backup.
I went for overkill here and used SuperDuper to made a bootable
internal backup on one of my Mac Pro’s internal drives, and
another one on an external drive.
After testing the external one, getting rid of some of my unused
applications, and updating the critical ones I took the plunge and
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OCALA MACINTOSH USER GROUP MEETING
OMUG MINUTES AUGUST 24, 2009— Preliminary
Tim Rankin began the meeting at 7:38 PM with updates on two absentee officers: President NC (on a photo
shoot/vacation in Alaska) and our Vice President, Phil (last-minute illness).
Announcements and Introductions: Welcome to our newest members, Antonio Bunker and Betty Lawrence, and
to our guests Bob and Martha Langford, Carolyn Thomson, and Loren Voge.
Speaker: Tim Rankin (per his agreement to fill in for Phil Davis)
Program Topic: Using your Scanner
Program Highlights:
•
		
		
		
		
•
		
		
		
		
•
		
		
		
		
•
		
		
		
		
		

Types include flat bed, sheet-fed, slide or drum scanners. Specifications include resolution, bit-depth,
dynamic range, scanning method, scanning area, and speed. Scanners also come in an all-in-one
configuration with scanner/copier/fax functions. Each brand and model has its own software, so check
instructions for specifics. A good reference for general tips online: http://www.scantips.com/.
Good scanners are quiet and fast!
In order to make a scanned document “editable” (able to be revised in a word processor), OCR (Optical
Character Recognition) software is needed to convert the image into text. Every scanner usually
includes at least a limited version of this software. Accuracy of OCR is dependent on the quality and
clarity of the original. Advanced OCR software is also available from third-party sources. A high-end
OCR software example is OmniPage.
Scanner vocabulary includes: resolution (or DPI=Dots Per Inch; particles of information per inch), bit
(as in 16, 24, 48-bit) which refers to the color depth, and OCR. “Marching ants” or a dashed frame line
are seen in Preview mode and assist in selecting the area of the original to scan. TIF, JPG, and GIF are
all image formats. Moire (mwah-ray) describes an interference pattern that appears on images that
have been scanned from a previously printed source such as a newspaper, magazine, or book.
Tim’s demonstrations included scanning documents, black and white line drawings, color graphics,
photographs, negatives, and slides, into Photoshop Elements 4.0. Questions were answered through
out the program. Tim’s Tips and Tricks included demos using the Straighten Tool, Image>Divide
Photos, keyboard shortcuts for sizing, and the Rubber Stamp Tool. His on-loan handout will be made
available to members via email or by following this link:
http://www.ocalamug.org/articles/using_your_scanner.pdf.

Members enjoyed refreshments, planned and served by Shirley Steiner and Joan Espenship.
50/50 Drawing Winners:
•
Sally Smyth, $25
•
Dennis Moeder, $25
•
Jack Wood, keyboard brush
Attendance: Thirty-three members were in attendance.
Meeting adjourned at 9:15 PM. Many thanks to members who stayed to move chairs!
Respectfully submitted by: Angie Wood, Secretary
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OMUG TREASURER’S REPORT — JULY 2009
Account Balance 8/1/09

............................................................................................ $1624.54

Income 7/27/09 Meeting:

50/50 Raffle....................................... $ 50.00
2009–2010 Memberships...................130.00....................+180.00

Account Balance 8/31/09.....................................................................................................................$1804.54
Respectfully submitted by
Judy Rankin for Clint Jones, Treasurer

OMUG Meeting Information

OMUG Assignments

The Ocala Mac User Group meets on the 4th Monday
of each month at the following location in the Silver
Springs area of Ocala:

Assistant Secretaries – Sally Smyth, Shelley Sizemore
Assistant Treasurer – Judy Rankin
Fifty-Fifty Raffle – Earl Satterfield
Membership – Judy Rankin
judyrankin@mac.com • 821-2322
Newsletter – Al Sypher
aes@imageocala.com • 237-9501
Refreshments – Shirley Steiner and Joan Espenship
Sunshine Lady – Virginia Baldwin
vbaldwin@atlantic.net • 629-6308
Webmaster – Philip Davis
ocalamug@gmail.com • 369-8432

Family Wellness Center— conference room
4817 NE 2nd Loop
Ocala, FL 34470
624-2337
See www.ocalamug.org for a map to the location.

OMUG Board of Directors
President – N.C. Sizemore
ncsizemore@gmail.com • 291-8778
Vice- President – Philip Davis
davistech@gmail.com • 369-8432
Secretary – Angie Wood
angie711@aol.com • unlisted
Treasurer – Clint Jones
jonesgins@aol.com • 351-9236
Member-at-Large – Bob Docteur
docteurr@aol.com • 624-0524
Member-at-Large – Judy Rankin
judyrankin@mac.com • 821-2322
Member-at-Large – Al Sypher
aes@imageocala.com • 237-9501
Past President, Ambassador – Tim Rankin
timrank@themacisp.net • 821-2322

Get Help— Mac Users Helping Mac Users

OMUG volunteers will try to help you with your
computer and software problems. Please add your
name to this list if you are willing to share your
expertise with other OMUG members.
General Mac Problems – Tim Rankin
timrank@themacisp.net • 821-2201
Print Shop or Print Explosion – Judy Rankin
judyrankin@mac.com • 821-2322
AppleWorks or MS Word – Curtiss Besley
cbesley@mac.com • 266-6760
General Mac Problems; Web Design – Philip Davis
davistech@gmail.com • 369-8432

Reminder the September Meeting of OMUG
is scheduled for the 28th with a 7:30 PM start time!
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